
Cisco WAN
Part Number OL-6332-01, August 13, 2004
C H A P T E R 3

Using the NMT

This chapter provides instructions for using the NMT interface, presents an overview of the modeling 
process, and lists NMT commands that update or extract information from NMT configuration files. This 
chapter contains the following sections:

• NMT Startup

• NMT Menu Bar

• File Menu

• Keyboard Commands

• Modeling Processes

• Error Checking

• Work Flow

The NMT models a network based on your input. Using your input about the network you want to model, 
the NMT helps identify the hardware needed by provisioning the chassis with front cards and back cards. 
The NMT routes the connections using the same software as the WAN switches, based on the Connection 
Admission Control (CAC). The NMT is aware of all physical and logical constraints that would prevent 
a connection or a trunk from being provisioned or routed. NMT is also aware of the different features 
and constraints in each major switch software release.

Connection routing can be verified in the network's basic state. The connection re-routing can be verified 
for any failure scenario. Simulation of failure of all network elements can verify the network's resiliency.

NMT Startup
If you are running NMT on a UNIX platform, start the NMT by entering the command nmt. This 
launches an xterm window for the NMT interface (Figure 3-1). 

If you are running NMT on a PC platform, start the NMT by clicking on the nmt.exe file located in the 
NMT/bin subdirectory. This launches an xterm window for the NMT interface
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NMT Menu Bar
Figure 3-1 NMT Main Window

NMT Menu Bar
The menus in the NMT main window contain selections for inputting data that describes the existing or 
proposed network. These menus also provide selections for generating optimized configurations and 
many different types of reports. (See Figure 3-2.) The menus are as follows: 

• File—Contains choices for opening, closing, deleting, and saving your file. It also provides options 
for importing and exporting files to other formats, changing paths, and viewing a summary of your 
network.

• Configure—Contains choices for describing the network model, including site names, links, and 
traffic types. 

• Execute—Provides choices for analyzing and optimizing the network model. 

• Display—Shows predefined reports describing the sites, links, required hardware, error messages 
and warnings, and much more. Includes a map tool selection for creating a graphical representation 
of your network. 

• Report—Provides options for generating, defining, and displaying reports. 

• Maintenance—Includes selections for modifying prices and part names and for specifying line 
costs. 

• Help—Provides information about how to use the program and describes many of the menus and 
menu items in the NMT.

• Quit—Exits the NMT application.
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File Menu
Figure 3-2 NMT Design Menu (All Menu Options Displayed)

When you highlight a menu item, a one-line description of the selection is displayed beneath the menu. 
The NMT Design menus and their menu items are further described in the sections that follow.

File Menu
You can access the following commands from the File menu in the Network Design Tools window:

• New—Opens a new file. Clears all read and entered topology information.

• Open—Opens a previously saved file.

• Save—Saves the current configuration.

• save as...—Saves the current configuration under a new name.

• Import—Reads configuration data from other formats and imports it into the current file.

– DBF—Import topology from DBF tables and the SSI MS Excel Interface.

– WANDL—Read the topology from the set of WANDL files specified by their SPEC file.

– MAP—Read any changes made with the Map interface back into the CNF file. 

Note Save changes in the map interface before importing that Map interface into the CNF file.

• Export—Writes the configuration data to other formats.

– DBF—Output table in DBF format for SSI MS Excel Interface.

– WANDL—Output topology in WANDL format for Further optimization and analysis.

– CSV—Output Tables in comma separation values.

• Read 2nd CNF—Merges all or some tables of one configuration file into another. This enables you 
to perform certain operations on two separate configuration (CNF) topologies. For example, 
updating the fields in one CNF table automatically updates the same fields in other CNF tables. You 
can also use this option to compare two CNF files.

• Delete—Erases the configuration file.

• Change Path—Changes the current directory path.
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• View Summary—Shows a summary of the current topology.

• Report Site—Shows a summary of a specific site.

Saving Configurations 

Save your configuration regularly. The directory path is shown in the bottom left of the window. When 
you read in configuration files, the path is updated to include the current filename. You can also change 
the path to read and store files in other directories.

To save a configuration, follow these steps:

Step 1 Select Save or Save as... from the file menu, or select Write from the Configure menu

Step 2 Enter a name in the Enter Name dialog box. (See Figure 3-3.) 

Step 3 Press Enter. 

Figure 3-3 File Save Window

Configure Menu
You can view the following tables from the Network Design Tools Error Checking option in the 
Configure menu:

• Sites—Configuration for Network Sites having one or more WAN switches, controllers, and/or 
feeders.

• Links—Existing links and possible links considered for the network design.

• Voice Traffic—Customer voice connections and T1/E1 emulation configurations.

• Data Traffic—Customer data connection information.

• Bursty Traffic—Customer Frame Relay, ATM, and Circuit Emulation connection information.

• Interfaces—Customer port assignment, configuration, and partitioning information.

• Feeders—Customer access feeders configuration for feeders not specified in the site table.

• Cards—Optional table for card slot assignment.

• Groups and Networks—PNNI domain names, parameters, hierarchy, and network domain names.
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• Nodes—User defined node types and restraints.

• Parameters...—Global network settings and model options.

• Utilities...—Utilities for making global modifications to the configuration file.

• Table Scan—Scans all loaded configuration tables for errors.

• Edit Options—Modifies the preferences.

• Read—Opens a previously saved file. This option is the same as Open in the File menu.

• Write—Saves the current configuration under a new name. This option is the same as Save as... in 
the File menu.

The configuration tables define all the network elements necessary for the model, and their parameters. 
All parameters not specified will default to the latest part available, or the maximum setting, or the 
standard setting. Many network elements can be defined explicitly in tables, or if not, the NMT will 
automatically generate implicit network elements. Figure 3-4 shows an example of a configuration table.

Figure 3-4 Sites Table

You can either input or import a configuration. 

• To input a configuration, you enter data into tables accessed from the Configure menu. For 
information about inputting a configuration, refer to the section “Keyboard Commands” earlier in 
this chapter, and see the chapter “Modeling Simple Networks,” which provides a step-by-step 
example of inputting a configuration. 

• To import data from Cisco Wan Manager (CWM), see the chapter “Configuration Extraction Tool”; 
to import (or export) WANDL files, see the chapter “Third-Party Interface”; to import (or export) 
Microsoft Excel files, see the chapter “SpreadSheet Interface.” 

For descriptions of the fields contained in the Configure menu selections, refer to Chapter 4, 
“Configuration Tables and Fields.” 

Note The NMT assumes that the version of the switch software you are using is the same as that of the NMT 
software. If that is not the case, select Model Settings from the Configure menu and specify the switch 
software version you are using by entering a release number next to Network Parameter Switch Software 
Release. Individual platforms can have unique switch software releases specified in the Site table.
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Utilities

Use the Utilities in the Config menu to make bulk changes to the CNF file.

• Expand Quantities — For all records for quantity field value of greater than one, change the quantity 
value to one and duplicate the record the number of times that appeared in the quantity field.

• Table Conn Merge — Merges connections with identical parameters into one table record, 
increasing the quantity field.   An additional feature enables you to set the options to average the 
traffic values to further reduce the table record count.

• Order Table Data — Options for sorting the CNF tables by site name.

• Rename or Merge Site — Modify site names.

• Group Rename or Merge— Modify group names.

• Adjust %Util— Modify the %util fields in the connection tables.

• Mesh Data — Add new records such that link or connection tables are fully meshed. Options 
determine how the mesh is to be done. The weight field in the site table can be used in several ways 
to affect the outcome of the mesh.

• VH Coordinates — Utilities to create VH coordinates for the map display.

• Path Expansion— Update paths with complete slot/port information.

• Diff Pref Route vs. Cur— Compare all preferred routes to the existing routes in the CNF file.

• Clear Data — Reset or blank out various fields in the CNF file.

• Upgrade Implicit — After running ROUTE or EXECUTE command, have NMT insert any multiple 
switches at one site as separate entries into the site table

• Feeder MGX8220’s — After running ROUTE or EXECUTE command, have NMT insert any 
implicit MGX8220’s at one site as separate entries into the site table

• Store Model Data — After running ROUTE or EXECUTE command, have NMT store various data 
back into the CNF file. Individual fields can be selected in an additional menu.

Edit Options

Edit Options invokes edit form that includes few flags that control UI in the edit tables

• Strict UI Checking — controls validation of some of the fields like link type, link front card, 
connection interface, etc. Note, that all the data will be checked in any cases during Execute 
operation. 

• Default CNF file — defines the name of CNF file that is used as a templates for edit tables. The first 
entry for each table in this file is used as default values when adding new table entries.

• Correct Table Data — controls writing back corrections that makes NMT back to the user data.

If set to ‘Y’ (default value), the NMT will write back to the CNF all the corrections it makes 
internally; if set to ‘N’ - user data will remain in the state the user sees them in the edit tables.

• Check Route Paths — Enables/disables route checking. 

• Suppress Duplicate Messages — After five similar messages appear in the log, suppress all 
additional messages of that type, and provide the count of suppressed messages.

If set to ‘N’ (default value), the UI will skip route checking, so it will be checked during Execute 
operation. If set to ‘Y’ the user will be able to check routes in the UI and correct them if necessary.
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Defaults

To create your own defaults for any or all tables, create a CNF file and call it DEFAULTS. Save it to your 
working directory. Any new records you create for a field in any table will have the values of the first 
entry in that table. To use an existing file for your defaults, select it in the edit options window.

Note This option does not apply to the site names field in any table.

Execute Menu
You can access the following commands from the File menu in the Network Design Tools window:

• Route—Routes traffic over specified links

• Fail Analysis...—Performs failure analysis on the lines and forces NMT to create alternate routes.

• Build Sites—Provisions the nodes without routing.

• Optimize—Uses selected links to create a least cost topology.

Display Menu
You can access the following commands from the File menu in the Network Design Tools window:

Sites Displays customer site information.

Links Displays a list of links in the current network.

Network Summary Displays summaries of the current network costs and routing status.

Total Links Load Displays static load estimates by traffic type for each link in the network.

ATM & Fr Ports Site name, connection type (for example, FRM-V35), slot number, port number, 
port speed (cells or packets per second), SUM MIN (port load). 

Data & Voice Ports Site name, connection type (for example, SDP-V35), slot number, port number, 
port speed.

Connection Routes Connection to/from, number of connections, connection type (for example, FR, 
56), path number of hops, delay time in msec for voice and NTS connections.

Failed Connections Displays failed connections and connections that have not been routed.

Parts List Listed by site, including part number, description, quantity, cost per site.

Resources Graphical display of each node’s card cage showing front cards and back cards.

PNNI Topology Displays PNNI logical links.

User Message View or clear the message log. You can also view the message log by entering 
<Ctrl> W.

Map Network topology map. 
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Report Menu
Use the Report menu to define, generate, display, and save reports. The menu contains the following 
options: 

Define Selects which tables to include in a report. Figure 2-5 shows the Define Report 
window. In this window you can specify the contents of the report and also add 
a report header. Enter one of the following options:

Y—includes a report in a report file.

N—do not include a report in the report file.

X—do not generate a report (saves execution time).

Generate Names and generates a report.

View Selects a report to display.

Erase Deletes a report from the current directory.

Path Sets the directory path. 

Set Options Specifies the following report variables:

• Price Option— Enter 0 for normal pricing. Enter a number from 1 through 5 
to specify number of years in lease.

• Detail Reports— Enter Y to generate Bursty Link Load Reports. Enter N to 
exclude Bursty Link Load Reports. 

• Output DBF Reports— Enter Y to create a report in DBF and text format. 
Enter N to create report only in text format.

• Output Pref Rte — Sets Preferred routes. Y to output a file of preferred 
routes that can be inserted into switch CLI commands to create those routes.

• Bundle Connections — Y will keep connections bundled by routing 
properties in the reports to reduce the size. N will expand reports for each 
individual connection.

• Output Map Info —Y will write the information from a NMT command to 
be input into the MAP graphical display. N will not to reduce execution time.

• Map Site Feeders — Y will display all feeder sites and their links on the map, 
N will display only routing nodes and links.

• Map MultiNode Sites — Y will display each switch in the case where NMT 
generated addition switches at a site, N will display only one marker for site 
table entry.
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Figure 3-5 Report Options

Maintenance Menu
Use the Maintenance menu to revise product costs, add optional equipment (for reference purposes), 
and provide information about line costs. This menu also allows you to read, write, erase, and set the 
path for maintenance files. The menu contains the following options: 

Help Menu
The NMT has several kinds of online help. The Help menu provides information about how to use the 
program and describes many of the menus and menu items in the NMT. 

Quit 
The Quit item on the NMT Menu Bar is used to close the NMT application. When you choose this option, 
a popup window appears asking whether you are sure you want to quit NMT. Type Y and hit return to 
quit. Type No and hit return to continue working in NMT.

Keyboard Commands
To select a top-level menu item in the NMT design window, use the left and right arrow keys. Press Enter 
to access a submenu. Select submenu entries with the up or down arrow key or by typing the first letter 
of the submenu entry. To exit from a table or menu, press Escape. 

Parts List Displays a list of Cisco Systems WAN part model numbers.

Line Cost Displays line cost information.

Read Loads a previously saved maintenance file.

Write Saves a maintenance file.

Erase Deletes a maintenance file.

Change Path Changes the current directory path.
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The NMT has many keyboard commands to help you create and revise configuration tables and reports. 
Table 3-1 lists the Sun workstation key assignments used for editing data in the NMT. 

Table 3-1 Sun Key Assignments

Key Function Description

F1 Field help Text description of the current field.

F2 Window help Displays a list of key definitions for data entry and editing.

F3 Copy line Copies the current line. The Repeat Line command then 
can be used to repeat it one or more times.

F4 Repeat line Inserts a previously copied line below the current line.

F5 Choice List Displays a list of key definitions for data entry and editing 
(same as F2).

Note This command is only available on the PC version 
of NMT. 

F6 Clear end-of-field Clears one field in a table.

F7 Delete line Removes the current line. The line deleted will be saved in 
a buffer from which it can be recalled by using the Undelete 
command.

F8 Insert line Inserts a table entry below cursor.

F9 Undelete line Inserts the last deleted line above the current line. If the 
command is repeated, the last deleted line that has not been 
undeleted (if any) will be inserted above the current line. A 
maximum of 50 lines can be undeleted.

F10 Cancel/Abort Table Exits a table without checking data. If the Exit command 
has been previously issued, the command will delete all 
lines in the table that contain illegal data.

Up Arrow Previous line

Down Arrow Next line/Add row Inserts default field values for new rows.

Left Arrow Previous Field

Right Arrow Next Field

Page Up Previous Page

Page Down Next Page

Home First Page, first row

End Last page, last line

Help, F12 Choices Lists choices for the selected field. Lists of choices are 
available for most fields that accept three or more 
non-numeric values.

In the site field, you choose a site by pressing Help (or F12) 
and then using the up or down arrows to scroll through the 
site names; press enter to select a site.

Esc Exit Exits a table or menu and, in some cases, checks the data in 
the table. 

Ctrl-f Find Site Prompts you for site name, and then finds the next table 
entry using that site name.
3-10
Cisco WAN Modeling Tools User Guide, Release 15

Part Number OL-6332-01, August 13, 2004



Chapter 3      Using the NMT
Modeling Processes
Help Keys
You can get help using keyboard commands as follows:

• Pressing the F1 key. If you are unsure what data to enter when the cursor is in a field of a table, you 
can press the F1 key to display a help screen that lists and describes the options for that field.

• Pressing the F2 key. This provides a description of the window editing and cursor capabilities of the 
function keys for a selected table. 

• Highlighting an item in a menu, which displays a one-line description.

• If you enter an unacceptable value (for example, IXG instead of IGX) into an NMT field, the system 
beeps and an explanation is displayed at the bottom of the window. 

• Press the Help or F12 key (or F5 in the PC version of NMT) to display a “Choice List”. You can 
scroll through the list to select a valid entry for the field. Not all fields have a choice list.

Message Keys
Enter Ctrl-w from any where in NMT to view working and error messages from your working session.

Modeling Processes
The NMT models your configuration when you select one of the options under the Execute menu. 

If there is any problem with your configuration, a message box displays the following message: 

New warning messages generated. 

To check your warning messages, enter Ctrl-w.

Ctrl-g Go to line/Display 
line

Reports line number of current table entry. Entering a 
number allows you to go to that specific table entry.

Ctrl-h First Field Moves cursor to the first field in the row.

Ctrl-j Last Field Moves cursor to the last field in the line.

Ctrl-k Left One Space Moves cursor left one character (within a selected field). If 
the cursor is on the first character in the field, this 
command moves the cursor to the previous field.

Ctrl-l Right One Space Moves cursor right one character (within a selected field). 
If the cursor is on the last character in the field, this 
command moves the cursor to the next field.

Table 3-1 Sun Key Assignments (continued)

Key Function Description
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The NMT generates three types of messages: 

• L—Log messages are generally displayed when the NMT records the command the user requested.

• I—Informational messages generally indicate that site or link parameters have been modified to 
comply with user entered data.

• W—Warning messages are generally displayed when the NMT modifies connection data. 

• E—Error messages are generally displayed when the NMT cannot create a topology because of 
incorrect data. 

The message box also keeps a log of the commands executed. The message box always scrolls to the last 
viewed message.

An example of warning output is shown in Figure 3-6. 

Figure 3-6 Example of NMT Warning Output

Error Checking
The NMT does automatic error checking in the following circumstances: 

• When you exit a data entry screen, the NMT automatically performs a line-by-line check of the data 
in your table.

• When you exit the Configure menu, the NMT checks your data again and, in many cases, makes 
corrections. If the NMT makes any changes or finds any errors, it generates information, warning, 
or error messages as needed. When this happens, you are instructed to select Warnings & Errors 
from the Display menu.

Note If you are working with a large configuration, you may want to exit the data entry screen without 
having the NMT perform a line-by-line check. To do this, press the F10 key instead of Escape 
key. 

• When you select Route, Optimize, or Build Sites from the Execute menu, the NMT checks your 
data and may make corrections. If the NMT makes any changes or finds any errors, it generates 
information, warning, or error messages as needed. When this happens, you are instructed to select 
Warnings & Errors from the Display menu.

To thoroughly check and correct all configuration tables in VI mode, select Table Scan from the 
Configure menu. 
3-12
Cisco WAN Modeling Tools User Guide, Release 15

Part Number OL-6332-01, August 13, 2004



Chapter 3      Using the NMT
Troubleshooting NMT
Troubleshooting NMT
The table below describes a common NMT problems and what can be done about it.

Symptom Your mouse does not work on the PC version of NMT. 

Note The mouse is not supported in the UNIX version of NMT.
Probable Causes The Quick Edit Mode option is checked in the Console window’s 

Properties<Options menu. 
Solution Open the Properties menu and ensure that Quick Edit Mode is not 

checked in the Options tab. If it is checked, click on the box next to 
Quick Edit Mode to un-check it, and then click OK.
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